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Introduction 

Overview 
The Building Design Advisor (BDA) software is the result of research and 
development efforts by the Building Technologies Department of the Environmental 
Energy Technologies Division at Ernest Orlando Lawrence Berkeley National 
Laboratory.  The objective of these efforts is to provide means for quick and easy 
consideration of energy-efficient and environmentally sustainable strategies and 
technologies from the initial, schematic phases of building design to the detailed 
specification of building components and systems. 
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The BDA is a software environment that supports the integrated use of multiple 
simulation tools and databases, through a single building model and a single 
graphical user interface.  Acting as a data manager and process controller, the BDA 
allows editing of the values of all parameters serving as input to simulation tools, 
supporting comparison of multiple alternative design solutions with respect to 
multiple descriptive and performance parameters. 

The development of the BDA concept and software has been supported by the U.S. 
Department of Energy (DOE) and the California Institute for Energy Efficiency 
(CIEE).  CIEE funds have been provided by Pacific Gas and Electric (PG&E), 
Southern California Edison (SCE) and the California Energy Commission (CEC). 

User interface windows 
The user interface of BDA has four main windows:     

• BDA Main Window 

• Schematic Graphic Editor (SGE) 

• Building Browser 

• Decision Desktop 

BDA Main Window 
The main BDA window opens automatically when the program is started.   It is used 
to manage projects and other BDA windows.  From here you may also retrieve 
online help.  

 
BDA Main Window 

Schematic Graphic Editor (SGE) 
The SGE provides a graphical interface for drawing spaces, windows, luminaires, 
external obstructions (building shades), etc.  It opens automatically when a project is 
opened.   

Although it appears as an integral part of BDA’s graphical user interface, the 
Schematic Graphic Editor is actually a separate Windows® application, which is 
launched by BDA when a new project is created or an existing project is loaded.   
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Schematic Graphic Editor (SGE). 

Building Browser 
The Building Browser is a navigational tool, which displays all of the building model 
objects in a hierarchical fashion and displays the parameters that characterize each 
object, as well as their values, units, and value source (database, user input, etc).  
Navigation is done in an environment similar to Windows Explorer™. Object and 
parameter values are edited using information dialog boxes that are activated through 
the Building Browser. 

 
Building Browser 

Decision Desktop 
The Decision Desktop displays the values of selected parameters for one or more 
Solutions.  The displayed parameters (Spatial Daylight Illuminance, Total Energy 
Use, etc.) are selected in the Building Browser.  
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Decision Desktop 

Supported simulation tools 
The current release of BDA is linked to three simulation tools, DELight, ECM and 
DOE1.2E.  The available outputs from these tools are listed below and defined in the 
Glossary. 

• DElight 

Spatial_Daylight_Illuminance 
Temporal_Daylight_Illuminance 
Temporal_Glare_Index 
Monthly_Electric_Lighting_Savings 
Annual_Electric_Lighting_Savings 

• ECM 

Spatial_Electric_Light_Illuminance 
Electric_Light_Illuminance for a reference point 

• DOE-2.1E 

Total_Energy_Use 
Total_Energy_by_Fuel_Type 
Total_Energy_by_End_Use 
Monthly_Energy_by_Fuel_Type 
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Monthly_Energy_by_End_Use 
DOE2_Annual_Electric_Lighting_Savings 
DOE2_Monthly_Electric_Lighting_Savings 

• DOE-2.1E + ECM 

DOE2_ECM_Annual_Electric_Lighting_Savings 
DOE2_ECM_Monthly_Electric_Lighting_Savings 

BDA files 
The BDA installation directory contains all the executables, databases, and other 
files associated with the BDA software. 

WARNING: Do NOT rename, delete or move any file from the BDA home 
directory or any of its sub-directories unless expressly directed to do so by your 
BDA support person. 

What's covered in this manual 
This manual is organized into the following chapters:  

1. "Object Oriented Environment" on page 9 describes the object-oriented 
representation for buildings used by the Building Design Advisor.  You 
should read this chapter first to familiarize yourself with the object 
environment terminology.  

2. "Getting Started" on page 13 describes how to open BDA, and 
describes the functions of the main BDA window, including creating 
new projects, opening existing ones, and saving your work. 

3. "Schematic Graphic Editor" on page 19 describes the Schematic 
Graphic Editor (SGE), a graphical interface for drawing spaces, 
windows and obstructions.  It opens automatically when a project is 
opened.   

4. "Building Browser" on page 35 explains the Browser's hierarchical 
navigation, and describes its functions, including editing and viewing 
object properties and parameter values. 

5. "Design Decision Desktop" on page 41 describes how to use the 
Decision Desktop and control the appearance of the output.  

6. "Tutorial" on page 49 provides a quick way to get started with using 
BDA. 

7. "BDA Building Model" on page 61 defines all the objects, parameters, 
and relationships used in the BDA Building Model. 
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Object-Oriented Environment 

Overview 
This chapter describes the object-oriented representation for buildings used in the 
Building Design Advisor.  You should read this chapter first to familiarize yourself 
with the object environment terminology.  

Object-oriented representation 

BDA Schema 
To facilitate the extendibility of the BDA building model, we have based its 
representation on a generic data schema, which consists of: 

• Building Objects (e.g. building, story, space, boundary, 
boundary_segment, aperture, etc.) represent building components and 
systems as “containers” for parameters.  Building objects are linked to 
each other through relationships. 

• Parameters (e.g. total energy use, floor-to-floor height, hot water use 
per person, surface area, etc.) represent the state of building objects 
with respect to the data input and output needs of the simulation tools 
that are linked to the BDA. 

• Relationships (e.g. composed of, part of, contains, contained in, etc.) 
represent links between the building object instances and provide a 
navigational framework for accessing those instances. 

• Values. Six different data types are supported for the values of 
parameters: 

• Integer 
• Real number 
• Text string 
• One-dimensional array of real numbers 
• Two-dimensional array of real numbers 
• Bitmap or image 
• Video and/or audio 
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• Units (e.g., ft, KBTU, fc, etc.) qualify the values of parameters. 

• Simulation Tools (DOE 2.1E, DElight, ECM, etc.) or processes, in 
general, use the values of certain parameters as input and produce the 
values of other parameters as output.   

Default value selection  
Every time a new object is created in the Schematic Graphic Editor (SGE), default 
values for each parameter and children objects are selected based on building 
location, building type, and space type.  BDA selects these values from a database, 
which has prototype information for different building objects.   Default values in the 
database come from respected sources such as ASHRAE, BOCA, CEC, and IESNA 
and are representative of standard and/or recommended practice.   

This feature allows activation of simulation tools with minimal input, saving a great 
deal of time that would ordinarily be required to determine and enter these values 
into a simulation tool.  Where desired, default values may be changed in the Building 
Browser. 

Object naming conventions 
When a project is created, the user must specify a name for it.  Building objects 
within the project that are created by the user are also to be named by the user.   
Objects created by the BDA through the default value mechanism are named 
according to BDA's object naming conventions.  

Building (BDA supports only one building per project at this time) is given the 
name of the project. 

Plenums are named by combining the name of the story to which they belong with 
the word "plenum" (e.g. Ground Floor Plenum). 

Boundaries, boundary segments and apertures are named by combining 
their object type with a unique object ID. (e.g. Wall 12, Floor 35, Ext Wall Seg 107, 
Int Wall Seg 149, or Window 77). 

Distribution systems, heating plants, and cooling plants are named by 
combining their object type with a unique object ID. 

NOTE: At this time, BDA supports one distribution system, one heating plant and 
one cooling plant per building. 

Objects for which only one of their object type can exist under the parent design 
object are named by their object type name, e.g. Construction, Frame, Glazing, 
Ground_Surface, Hourly_Schedule and Monthly_Schedule. 

Parameter types 
Descriptive Parameters have values that are either default values selected by BDA 
when the parent object was created, or values entered by the user.   Parameters with 
default values are identified in the Browser by a computer icon to the left of their 
name.  Parameters with user-defined values are identified in the browser by a human 
face icon to the left of their name. 

Derived Parameters occur at the site level only.  Values are taken from a BDA 
database, such as TMY2 weather data, and are always identified with computer icons 
in the building Browser. 
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Geometry Parameters have values that are derived from the drawing in SGE and are 
always identified with human icons and are linked to user names. 

Performance Parameters have no values until they are placed on the Desktop, i.e., 
selected as output parameters, and their values are calculated by the simulation tools 
that are linked to the BDA.  They are always identified by a computer icon.  If a 
performance parameter has a value, its Source field contains the name of the 
simulation tool that calculated the value. 

NOTE: If a value is not an integer, a real number, or a string, then the Value field in 
the Browser may contain the name of a file where the value (real array or table, 
bitmap, audio or video clip) actually resides. 
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Getting Started 

Overview 
This chapter describes how to start BDA and use the functions of the main BDA 
window, including creating new projects, opening existing ones, and saving your 
work. 

Launching BDA 
Select Building Design Advisor from the Programs section of the Start Menu 
on your desktop.  The main BDA window will open. 

 
Main BDA window 

This window is used to manage projects and open other windows.  From this window 
you may also access the online help files.  This chapter addresses the Project menu 
functions.  For information on the Simulation Tools menu, see the Decision 
Desktop chapter. 

Managing projects 
A BDA Project must be created for each building analyzed.  A project consists of a 
site description and one or more design alternatives, or Solutions.  Currently BDA 
does not support multiple buildings on one site.   

Create a new project 
To create a BDA Project, select New from the Project menu.  The Creating a New 
Project dialog box will open.   
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Create New Project Dialog Box 

You must enter a unique name for the project in the Name field.  Other required 
fields include Building Type, Country, State, and City.  Default values are entered in 
these fields; however, you should change them if they are different for your project.  
The Description field is the only optional field.  The remaining fields are not user-
changeable. 

To complete the creation of your new project: 

1. Enter a unique name in the Name field.  The existing names appear on 
the left-hand side of the dialog box. You may enter a short description 
of the project if desired. 

2. Select a Building Type from the pull-down list.  The current selections 
are Lodging, Restaurant, and Office.  The building type is used for the 
selection of default values.  If the building type that you want is not 
represented, choose one of the available types and change the default 
values using the Building Browser. 

3. Select a Unit Type from the pull-down list. The choice is between the 
English unit system and the Metric unit system. All the numerical 
parameters in the project will have their values displayed in the selected 
unit system. 

4. Select an option from those available on the Country, State and City 
(TMY2 Site) pull-down menus.  If your city is not available, select one 
that is similar in climate to the one you are designing for.  You may 
also add a new TMY2 file to the database as described in the section 
"Add a new TMY2 file" on page 15. 

5. Click OK when you have finished specifying values for your project. 

 CAUTION: Once you click OK, the information entered here cannot 
be changed because these values are used to select default values for 
building object parameters.  If you want to change this information 
later, you must create a new project.  See also "Import a project" on 
page 17. 
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 Note: The Current User field is not changeable and is same as the 
current Windows user.  BDA keeps track of the user associated with 
each change to the project from beginning to end.  Using a different 
login name for each user who edits the project will be useful in 
managing the project. 

Add a new TMY2 file 
Adding TMY2 files can only be done from the Creating a New Project dialog box.  
You will first need to see that the appropriate file is on your computer.  Only a 
selection of cities are included with the BDA software, so you may need to download 
the data from another location, such as the website 
http://rredc.nrel.gov/solar/old_data/nsrdb/tmy2/. Note that BDA does currently 
support non-U.S. cities as long as you can provide a TMY2 formatted file for your 
city. 

To add a new TMY2 file:  

1. Open the file "Countrymap.txt" located in the "BDAData" folder within 
the directory where BDA is installed. If your city is not included in this 
file, add a line to the file specifying the city (exactly as it is specified in 
the TMY2 file) and the country. 

2. Open the file "BDADesDay.txt" located in the "BDAData" folder 
within the directory where BDA is installed. If your city is not included 
in this file, add a line to the file specifying the city (exactly as it is 
specified in the TMY2 file), its WBAN, and its Design Day 
information. (The Design Day information is used by BDA for display 
purposes only. It is not used in any of the calculations.) 

3. Open the Creating a New Project dialog box. 

4. Click on the Add New TMY2 File button.   

5. Browse to the directory containing the appropriate TMY2 file.  Select 
the file and click OK.  TMY2 files have the suffix .tm2.   

6. If the file was imported correctly, the new city name will appear on the 
City pull-down list when you select the country and state. 

Open an existing project 
The Open Project option will only be available if previously-saved projects exist.  
Only one project may be open at a time, so if a project is already open, it will be 
closed, and you will be prompted to save any changes. 

To open a project: 

1. Select Open from the Project menu.  The Open Project dialog box 
will appear.   

http://rredc.nrel.gov/solar/old_data/nsrdb/tmy2/
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Open Project dialog box 

2. Select the project you wish to open from the Existing Projects list.  
Information associated with that project will be displayed but cannot be 
changed. 

3. Click OK or double click on the selected project name.  

Close project 
To close a project, select the Close option on the Project menu.  If your project has 
not been saved, BDA will ask you whether you want to save your final version.   

Save project 
To save your work without closing, select Save from the Project menu.  When you 
close a project or exit BDA, you will be prompted to save your work.  Click Yes to 
save your changes in the project database.   

Rename a project 
Before you rename a project, you must close the project you want to rename.  To 
rename a project: 

1. Select the Rename option from the Project menu.  The Rename 
Project dialog box will open.  

2. Select the project you want to rename and enter a new name for the 
project.  

3. Click OK.  

Save a project under a different name 
To save the current project under a different name: 

1. Select Save As from the Project menu. The Save As dialog box 
will open. 

2. Select the location where you want to save the project and enter a new 
name for the project. 

3. Click OK.  
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Sharing projects 
BDA does not allow copying of projects for use as templates or sharing with others.  
To work around this, you may use the Import Project and Export Project functions 
described below.   

Export a project 
To export a project:  

1. Select the Export option on the Project menu.  The Export Project 
dialog box will appear.   

  
 Export Project dialog box 

2. Select the project to be exported and type in the directory of the export 
destination, or click on the Browse button in the dialog box and select 
the desired destination folder.   

3. Click OK. 

The exported BDA project will consist of several files which will be placed in the 
dirctory specified in the Export Project dialog box.  None of these files should be 
renamed. 

Import a project 
To import a project: 

1. Select the Import option on the Project menu.  The Import Project 
dialog box will open.   
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Import Project dialog box 

2. Click on Browse and navigate to the directory of the exported project 
you wish to import.  Select the project file ending in .db.  

3. Click OK to import the project. 

You can only import files exported from BDA, which will have the format 
projectname.db, where projectname is the name of the project to be imported.  BDA 
will not allow you to import a project with a name identical to that of an existing 
project. 
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Schematic Graphic Editor 

Overview 
The Schematic Graphic Editor (SGE) provides a graphical interface for drawing 
spaces, windows, and external obstructions (building shades), etc.  It starts 
automatically when a project is opened.   

This chapter describes how to create a geometric representation of your building 
using the Schematic Graphic Editor.   

 
Schematic Graphic Editor (SGE) 

Design Solutions 

Creating new design solutions 
When you create a new project, the SGE opens, but no drawing screen is visible.  
The first step is to create a new solution.  Then you will be able to create stories, then 
spaces and external obstructions, then apertures (windows) and other building 
objects.   
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The BDA supports multiple design solutions for a single project.  Selecting New 
Solution from the SGE toolbar or menu will create an exact copy of the current 
solution.  You may continue with changes to any of the existing solutions.  

CAUTION: At this time, there is NO undo in BDA.  All changes are final for the 
current solution.   You may still delete objects and change values.   

Create a new solution 
To create a new solution: 

 
Click to create a new 
solution. 

 

1. Click on the New Solution button or select New Solution from the 
File menu in SGE.  The New Solution dialog box will open. 

 
New Solution dialog box 

2. Specify a name for the new solution, and optionally, a brief description. 

3. Click OK.   

If no previous solution exists, a new story will automatically be 
created, and you will be prompted to give it a name.  This will be the 
ground story, and a new drawing grid will appear in the SGE window.  

If one or more solutions already exist, a new drawing window will 
open, and the current solution will be copied into the new solution.   

To copy a particular solution, make sure that solution is active when 
you create the new solution. 

 

Drawing in SGE 
Before you begin drawing, you may want to change the grid settings so that your 
entire project will fit on the screen.  The default grid setting is a 200 foot by 100 foot 
grid with a four-foot grid interval.  For details on how to change these settings, see 
"View/Change the drawing settings" on page 25. 
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Create a new story 

 
Click to create a new story 

 

Before you can create a space, you will need to create a story.  To open the New 
Story dialog box: 

1. Click on the Story button on the SGE tool bar, or select the menu item 
Object →→→→ Create → Story in SGE.  The New Story dialog box will 
open.   

 
New Story dialog box 

2. Specify a name for the new story, its height, optional plenum and 
plenum height. The level is displayed but is not editable. 

3. Click OK. 

Note: By default, roofs are created with each space.  If a space is drawn on top of 
another space (at the story above) then the BDA will remove the roof from the space 
below.  One of the limitations of the current version of the BDA is that even if there 
is a partial overlap, the BDA will remove the whole roof, meaning that it will 
consider it as an adiabatic surface (no heat transfer). 

Draw a space 
Once you have created a story, you may add one or more spaces to it.  You may add 
windows, luminaires, overhangs, and fins to spaces.  You may also create external 
objects of specified dimensions.   

 
Click to create a space 

To draw a space in the current story: 

1. Click on the Space button on the SGE tool bar, or select the menu 
item Object →→→→ Create →→→→ Space.   

2. Select a space type from the drop down list of available space types. 
The cursor will change to the drawing mode cross-wire shape.  

Press the Esc button to cancel the space creation. 
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Select a space type from this 
list. 

3. Once you have selected a space type, the cursor will turn into a cross-
wire. To draw, click and release the left mouse button once to specify 
the beginning point of the wall segment that will define the new space.  
Move the mouse to draw a wall.  Click and release again to end a wall 
segment and continue with another. 

If you want to backtrack your steps, press  the Esc button to take you 
back one step at a time.  

4. Double click to close the resulting polygon and define the space. 

5. When you finish drawing a space, the Space Name dialog box will 
open.  Type in a name and click OK.  

6. The name of the new space appears on the screen as a floating graphic 
object attached to the cursor. Do not click yet!  

7. Before anchoring the name to the space, you should move the name to 
the location you wish it to appear by moving the mouse.  You can 
increase or decrease the font size using the “+”, or “–” keypad keys and 
you can rotate the orientation of the name 45° at a time by pressing the 
r key.   

8. When you are satisfied with the name’s position, font size and 
orientation, anchor the name to the space by clicking the left mouse 
button.  
 
CAUTION: Once you have positioned the name, changing the size and 
orientation is no longer possible.  

 

Note 1: The co-ordinate system display system at the bottom of the SGE window 
shows relative values of co-ordinates of the current segment while a space is being 
drawn. Once a space is closed, SGE switches back to the absolute co-ordinate 
display.  

Note 2: The DELight simulation tool which performs the daylighting calculations 
can only model rectangular spaces.  Similarly, ECM, the simulation tool that 
performs the electric lighting calculations can only model rectangular spaces. If non-
rectangular spaces are drawn, daylight and electric light output parameters do not 
appear in the Browser. 

Draw an external obstruction 
External obstructions may only be drawn at the first level of a building.   Building 
shades are generally trees or neighboring buildings, and are also referred to as 
building shades.  The only properties assigned to an external obstruction in the SGE 
are its geometric shape and dimensions.  The values of other parameters, such as 
surface properties, are assigned default values which may be changed in the Building 
Browser.  
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To draw an external obstruction: 

 
Click to draw an external 
obstruction. 

 

1. Click the Building Shade button on the SGE toolbar or select the 
menu option Object →→→→ Create →→→→ External Obstruction.  The 
External Obstruction dialog box will open. 

 
External Obstruction dialog box 

2. Enter the dimensions in the dimension fields.  The diagram on the left 
side of the dialog box indicates the dimensions graphically.  H is the 
height of the object and O is the distance between the object and the 
ground.  The default values are roughly the dimensions of a small tree. 

3. Click OK.  

4. The cursor will turn to a cross-wire shape.  Draw the external 
obstruction as you would a space.  Refer to "Draw a space" on page 21 
for details. 

Draw a window 

. 
Click to draw a window 

To draw a window in SGE: 

1. Select a space to contain the window by clicking on it.  The easiest way 
to select a space is to click on its name.   

2. Click on the Window button of the SGE tool bar, or select the menu 
item Object →→→→ Create →→→→ Window.   

3. Click and release the left mouse button on the point in a wall from 
where you want to start drawing the window.  Move the cursor up to 
the desired endpoint of the window 

4. Click and release the left mouse button once again.  A turquoise line 
representing the window will appear on the wall. 

Add an overhang to a window 
To add an overhang to a window: 

1. Click on a window to contain the overhang.  When a window is 
selected, the Overhang and Fins buttons on the SGE toolbar will 
become active. 
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Click to insert overhang 

 

2. Click the Overhang button on the SGE toolbar, or select the menu 
item Object →→→→ Create →→→→ Overhang.  The Create Overhang dialog 
box will appear. 

 

  
Insert Overhang dialog box 

3. Enter the desired dimensions in the dimension fields.  The diagram on 
the dialog box indicates the dimensions graphically.  The dimensions 
specified are length, horizontal and vertical offsets from the window, 
and angle of inclination from the wall (measured from the window 
plane upwards).  The overhang is assumed to be centered horizontally 
above the window.  

4. Click OK when done to create the overhang.  A red icon representing 
the overhang will appear next to the window.  It is NOT drawn to scale.  

 
Window with overhang icon 

Add vertical fins to window 
Fins may only be added as a pair, one pair per window.  If you wish to add only one 
fin, set the values of the dimensions of the other fin to zeros. 

To add a pair of vertical fins to a window: 
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Click to add fins to a window 

 

1. Click on the window to contain the fins.   

2. Click the Fins button on the SGE toolbar, or select the menu item 
Object →→→→ Create →→→→ Fins.  The Create Fins dialog box will open. 

 
Add Fins to a Window dialog box 

3. Enter the desired dimensions in the dimension fields.  The diagram on 
the dialog box indicates the dimensions graphically.  The left and right 
fins are specified separately.  For each fin, you may specify the height, 
width, and vertical and horizontal offsets from the window. 

4. Click OK when done.  A pair of green lines representing the fins will 
be added to the window.  They are NOT drawn to scale. 

 
Window with fins icon 

Add luminaires to a space 
To add luminaires to a space: 
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Click to add a luminaire to a 
space 

 

1. Select a space to contain the luminaire by clicking on it.  The easiest 
way to select a space is to click on its name.   

2. Click on the Luminaire button of the SGE tool bar, or select the menu 
item Object →→→→ Create →→→→ Luminaire.   

3. Click and release the left mouse button on the point inside the space 
where the luminaire is to be located. A green icon representing the 
luminaire will appear at the insertion point.  It is NOT drawn to scale. 

 
Space with luminaire icons 

4. Repeat steps 2 and 3 to add more luminaires. 

Add reference point to space 
To add a reference point to a space: 

 

 
Click to add reference point 
to space 

 

1. Select a space to contain the reference point by clicking on it.  The 
easiest way to select a space is to click on its name.   

2. Click on the Reference Point button of the SGE tool bar.   

3. Click and release the left mouse button on the point inside the space 
where the reference point is to be located. A red icon representing the 
reference point will appear at the insertion point. 

 
Space with reference point icons 

4. Repeat steps 2 and 3 to add more reference points. 

View/Change the drawing settings 
The information bar at the bottom of the SGE window displays the Grid Snap 
interval, the Grid Snap state (On/Off) and the x-y-z coordinates of the cursor.  The 
grid settings, including drawing area and grid color, may be changed using the 
Drawing Settings tool. 
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Click to adjust the Drawing 
Settings 

 

To change the drawing settings: 

1. Click on the Drawing Settings tool in the SGE tool bar, or select the 
menu item View →→→→ Drawing Settings.  The Drawing Settings dialog 
box will open. 

 
Drawing Settings dialog box 

2. You can select or deselect the Show Grid.  The Snap to Grid checkbox 
is always checked to make sure that the BDA understands when walls 
coincide.  This is necessary for the automatic computation of interior 
and exterior walls for the assignment of proper default values for wall 
construction.  You may also change the Grid Step and Grid Snap 
intervals, as well as the Drawing Area Width and Drawing Area Height 
by typing in the appropriate text entry field; or change the Grid Color 
by clicking the Change Color button. 

3. Click OK to apply changes or Cancel to leave settings unchanged. 

 

Change the building azimuth 
The Building Azimuth is displayed in a text field on the top right hand corner of 
the SGE.  It may be changed by typing any number between 0 and 360 in this text 
field. The Building Azimuth is given as the clockwise angle (in degrees) between 
true north and the building Y-axis. By default it is 0 degrees. 

Basic SGE functions 
This section describes basic SGE operations that are meant to facilitate schematic 
design by allowing you to move spaces around, while BDA takes care of 
recomputing interior and exterior wall segments.   
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Select object 
 To select an object, click on the object.  The easiest way to select a space or external 

object is to click on its name.  When an object is selected, red selection marks appear 
at its corners. 

 
Selected space 

Move object 
To move an object to another position on the SGE drawing grid: 

 

 
MovexObject Tool 

1. Select the object to be moved.  

2. Click on the Move Object button on the SGE tool bar or select Move 
under the Object menu.  The mouse cursor will appear as a thick cross 
on the solution grid.  Click the mouse anywhere on the grid to "pick 
up" the object.  Use the mouse to move the object to its new location.    

3. Click the mouse again when you have positioned the object at the 
desired location.  

NOTE: If you try to move an object to a position not allowed by BDA, 
the object will return to its original position.  For example, spaces may 
not overlap, so if you move a space to a position overlapping another 
space, the SGE will move the space back to its original location.  

Resize window 
To resize a window: 

1. Select the window.   

2. Click once on the edge of the window you wish to move.  

3. Use the mouse to reposition the window edge.   

4. Click again to fix the window size.    

Zoom in 

 
Zoom In Tool 

To zoom in on any particular point of the drawing, click on the Zoom In button on 
the SGE tool bar or select Zoom In from the View menu.  Click to select one corner 
of the area you want to zoom in to.  Move the mouse cursor to draw a box around an 
area to zoom in.  Click the mouse again and the screen will zoom in on the selected 
area.  You can repeat Zoom In many times as needed. 

Zoom-to-fit (zoom out) 

 
Zoom Out Tool 

To view the entire drawing, click on the Zoom-To-Fit button on the SGE tool bar 
or select Zoom-To-Fit from the View menu.  There is no incremental zoom out.  
Use this function if you have zoomed in on a particular object and wish to return to 
the normal view. 
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Plan view (2D) 

 
Click to use Plan View 

SGE by default sets the drawing to the Plan View, a 2-dimensional view.  If you 
used a different view and need to return to the Plan View, select the Plan View 
button from the SGE tool bar or select menu option View →→→→ Change View    →→→→ 
Plan View.   

You must be in Plan View to use most of the SGE functions. 

Isometric view (3D) 

 
Click to use Isometric View 

To switch your view to the Isometric View, or 3-dimensional view, select the 
Isometric View tool from the tool bar, or select the menu option View →→→→ 
Change View →→→→ Isometric View.  

It is often useful to switch to the Isometric View to view your structure in 3 
dimensions.  Most SGE functions, however, cannot be used in this view.   

 
3D isometric view 

Change viewer position settings 
While in the Isometric View, you can change the Viewer Position Settings.  To 
change the Viewer Position Settings: 
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3-D Viewer Position Tool 

 

1. Click on the Viewer Position Settings button or select Set 
Viewing Position from the View menu. The Viewing Position dialog 
box will open. 

 
Viewing Position dialog box 

2. Select the desired horizontal, vertical, and angular direction for view.  
You may also select the Use as default setting checkbox to make the 
specified viewer position the default view.  

3. Click Apply to apply your changes. 

Modify layer settings 
The Layer Settings function controls the appearance of objects in SGE.   For each 
story, each object type is grouped into a layer.  Using the Layer Settings function, 
you can decided whether the layer should be shown, and decide its color and line 
type. 
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To modify layer settings: 

 
Layer Settings Tool 

 

1. Select the Layer Settings button from the SGE tool bar or select 
Layer Settings from the View menu.  The Layer Settings dialog box 
will open.  

Layer Settings dialog box 

2. To change the settings, select the desired layer and change its 
properties in the Layer Properties box on the right, including Name, 
Status (On/Off), and Line Style.   

3. Click Apply to save your changes.   Select another layer to edit if 
desired.  Note your changes are only applied to the current layer and 
story. 

4. When you are done editing layers, click OK to exit the dialog box. 

Edit thermal zones 
DOE 2.1E models spaces as thermal zones.  The thermal zone options have been 
disable in this version of BDA. 

Edit lighting zones 
Lighting zones can be defined by associating luminaires with a reference point. The 
luminaire(s) and reference point(s) need to be added to the space before lighting 
zones can be created. To make this association: 
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Light Zoning Tool 

1. Select the space that will contain the lighting zone.  

2. Click on the Light Zoning button on the SGE tool bar.  The Light 
Zoning dialog box will appear. A drop-down list of reference points 
will be filled if there are reference points in the space. A list of 
luminaires existing in the space is also shown in the list box on the left. 
If the reference point has had luminaires associated with it previously, 
these will appear in the list box on the right. 

 
Lighting zone editor  

3. Select a reference point from the drop-down list. 

4. To add luminaires to the selected reference point, select luminaires 
from the list box on the left and click on the "Add to Reference Point" 
button. 

5. To remove luminaires from the selected reference point, select 
luminaires from the list box on the right and click on the "Remove 
from Reference Point" button. 

6. Click OK when done.  

NOTE: You can create multiple lighting zones, but at this time BDA 
can model only one lighting zone per space. To specify the lighting 
zone for BDA to consider, see "Edit lighting controls".  

Edit lighting controls 
A reference point can be associated with the lighting control system for the space. 
The associated reference point will then act as a sensor for controlling the lighting 
levels. To make this association: 
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Lighting Controls Tool 

1. Select the space for which the lighting controls need to be defined.  

2. Click on the Lighting Controls button on the SGE tool bar.  The 
Lighting Controls dialog box will appear. A drop-down list of 
reference points will be filled if there are reference points in the space. 

 
Lighting controls editor 

3. Select a reference point from the drop-down list. 

4. Click OK when done.  

 

View/Edit object properties 
When you create an object in SGE, it is automatically added to the BDA building 
model and is visible in the Building Browser.  The Object Properties in SGE will 
only allow you to view and edit properties that are relevant to the SGE.       

You can locate the corresponding Building Browser object for a given SGE object 
using the Highlight Object in Building Browser function.   

View/Edit SGE properties 
SGE properties are specified by the user who creates the object.  These properties 
may be viewed or changed at any time.  To view or edit SGE properties of an object: 

• Select Properties from the SGE Objects menu. 

or 

• Right-click above the object and select Properties from the pop-up 
menu. 

An object properties dialog box will open.  Click OK when done. 

Highlight object in Building Browser 
To highlight an object in the Building Browser: 

1. Right click above the object. 

2. Select Highlight Object in Building Browser from the pop-up 
menu.   

The Building Browser window will open, and the selected SGE object will be 
selected in the Building Browser window. 

See the Building Browser chapter for more information. 
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Edit Solution Properties 
The Name and Description of the Solution can be changed through the SGE.  

1. Right click on the drawing screen of the SGE in an area which is empty 
and does not have any objects drawn. 

2. Select Solution Properties from the pop-up menu. The Solution 
properties dialog box will appear. 

3. Make the necessary changes and click OK. 

Edit Story Name 
The Story Name can be changed through the SGE.  

1. Right click on the drawing screen of the SGE in an area which is empty 
and does not have any objects drawn. 

2. Select  Change Story Name from the pop-up menu. The Object 
Name dialog box will appear. 

3. Make the necessary change and click OK. 
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Building Browser 

Overview 
The Building Browser organizes all the building objects in a hierarchical manner and 
gives the user a simple and familiar means of navigating through the BDA building 
model and editing the values of objects and parameters.  The Building Browser also 
allows the selection of input and output parameters for display in the Decision 
Desktop. 

While parameter values may be edited using the Building Browser, new objects must 
be added using the Schematic Graphic Editor. 

Open the Building Browser 

 
Click to open thexBuilding 
Browser 

To open the Building Browser window, select the Building Browser option on the 
BDA Windows menu or click on the Building Browser button on the BDA tool 
bar.   

Navigating in the Building Browser 
The Building Browser follows the paradigm of the Microsoft Explorer/File Manager 
utility.  When the Browser opens, the current solution is displayed.   

Change the current solution 
 If you have created more than one solution, the Building Browser will default to the 

current solution. 

To change the solution displayed in the Building Browser, select the desired solution 
from the Solutions drop down list, located at the top of the Building Browser 
window. 
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Browser layout 
The Building Browser has two main panes.  The left pane displays the object 
instances and their relationships.  The right pane displays related object Instances 
and the parameters associated with object selected in the left pane.  

The figure below shows a hierarchical list of objects, for the project "MyOffice" in 
San Diego, California, in the left panel of the Building Browser window.  Each 
object type is identified by a specific icon.  Clicking on the plus sign to the left of an 
object icon expands that object instance and displays its related object instances 
below and slightly right-indented from the icon.  Clicking on the minus sign 
collapses the expanded object. 

 
The Building Browser window 

The right pane of the Building Browser window displays the parameters associated 
with the object selected in the left pane.  Clicking on a column header will sort the 
displayed parameters by the values in that column. 

The first column contains the names of the parameters associated with the object 
selected in the left pane.  Parameters with default values are indicated by a computer 
icon to the left of the parameter name.  Parameters with user-defined values are 
indicated by a human icon to the left of the parameter name.  When the default value 
of a parameter is changed by the user, the computer icon is converted into the icon of 
a human face and the user's name is displayed in the Source column.   

The other columns display the parameter values, units, and type.  The last column 
contains the source of the parameter value.   

Relationships 
As you explore the Building Browser, you will notice the obvious hierarchical 
relationships (parent-child) between buildings and stories, stories and spaces, spaces 
and boundaries, boundary segments and apertures (windows), windows and glazing, 
etc.  The plus sign to the left of the object icon indicates that it has children objects.  
Childless objects have no plus sign. When an object is deleted, all of its children 
objects are deleted.  All of the relationships between objects are defined in the BDA 
Building Model. 
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Using the Building Browser 
This section describes how to use the functions of the Building Browser. 

View/Change object properties 
Object value information is available in the Building Browser.  You may change the 
value for an object with the Object Properties dialog box.   

To open the Object Properties dialog box: 

1. Double click on the object in the right pane of the window. The Object 
Information dialog box will open.  Information about the object and 
current value will be displayed but not user-changeable.  A list of 
available value options is displayed in the lower part of the Object 
Properties dialog box. 

Some objects have geometric properties, which are displayed on a 
different tab in the same dialog box.  This includes Object Type, Object 
ID, Object Instance Name, Azimuth, Tilt, Area, Volume, and  Vertices.  
These values can only be changed in the SGE, so the information is 
read-only. 

 
Object Information dialog box 

2. To change the value of an object, select a new value option from the list 
of available options, by clicking on its name.  Clicking on a column 
header sorts the available options according to the column header 
clicked.   

3. Select either the Change only the current object radio button or the 
Change all objects with the same value radio button.   

4. Click OK to change the object, or Cancel to abort the change. 
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View/Change parameter values 
To change the value of a parameter: 

1. Right-click on the parameter icon in the Building Browser and select 
Properties from the pop-up menu. Alternatively, you can double click 
on the parameter name. The Parameter Information Dialog Box 
will open.   

 
Parameter Information dialog box 

2. Enter the new value and click OK. 

NOTE: In this version of the BDA, you can change the value of most Descriptive 
Parameters in the parameter list.  Changing values should be done carefully, to avoid 
impossible combinations, e.g., a glazing whose transmittance, reflectance and 
absorption add up to more than 100%. 

Select parameters for display in the Desktop 
To select a parameter for display in the Decision Desktop: 

1. Click in the checkbox to the left of the parameter’s icon.  A red “X” 
should appear indicating that the parameter has been selected.   

2. Select one or more desired parameters from any object and click the 
Update Desktop button on the Building Browser window.  The 
selected parameters will appear as row headers on the Decision 
Desktop.   See also "Design Decision Desktop" on page 41.   
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Selecting output parameters 

To remove parameters from the Desktop, click the checkbox containing a red "X" to 
deselect the parameter.  Clicking Update Desktop will remove the parameter from 
the Decision Desktop 

Highlight object in SGE 
To locate an object in the SGE, right-click on the object icon in the left pane of the 
Building Browser, and select Highlight Object in SGE from the pop-up menu.  

A red asterix will appear next to the object in the Building Browser and the object 
will take on a purple color in the SGE.  You can highlight a whole space, or just a 
window or wall segment. 

To remove the highlighting of an object, right-click on the object icon in the Browser 
and select  Unhighlight Object in SGE from the pop-up menu.
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Design Decision Desktop 

Overview 
This chapter describes how to use the Decision Desktop and control the appearance 
of the graphical display of parameter values.  

The Design Decision Desktop, or simply Desktop is the Graphical User Interface 
(GUI) element that helps you compare the performance of multiple design 
alternatives with respect to multiple parameters.  The concept is very simple – the 
columns represent design Solutions and the rows represent individual descriptive or 
performance parameters.   
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Open the Decision Desktop 

 
Click to open Decision 
Desktop 

 

If the Decision Desktop window is not already open, you may open it by selecting 
Decision Desktop option from the Windows menu on the BDA main window or 
by clicking on the Decision Desktop button. 

 
Decision Desktop window 

Click here to view Decision Desktop window. 

The contents of the Decision Desktop are controlled by actions in the Building 
Browser and SGE.  This chapter refers back to the chapters on the Schematic 
Graphic Editor and the Building Browser several times, so it may be useful to read 
those sections first.  

Desktop parameters 
Parameters are represented as rows in the Desktop.  The name of the parameter is 
displayed in the first column, and its values for each solution are displayed in the 
corresponding Solution column.  

Select parameters for display 
Parameters are added and deleted from the Desktop using the Building Browser. 

To add or delete parameters on the Desktop, follow the procedure described under 
"Select parameters" on page 38.  The output parameters you select will be displayed 
on the Desktop.   
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Move parameters 
At this time, parameters cannot be moved in the Desktop.  If you wish parameters to 
appear in a certain order then you must select them in that order.  Otherwise, you can 
remove the parameters and then reselect them in the appropriate order desired. 

Calculate selected parameters 

 
Click to Calculate Values 

To calculate the values of the performance parameters displayed in the Desktop for
the current solution: 

Select Calculate Results from the SimTools menu on the main BDA toolbar, or
click the Calculation button on the main BDA toolbar. 

You can also click on any solution name on the Desktop to recalculate its results. 

Note:  If changes have been made that affect the parameter values, the solution 
names on the Desktop column headers will appear in red, indicating that results need 
to be recalculated.  The Status field in the Building Browser will indicate that the 
current solution is Stale. 

 The appropriate simulation tools are activated automatically by BDA to calculate 
values for the performance parameters currently on the Decision Desktop and the 
results are displayed in the corresponding cells of the Decision Desktop matrix. The 
Status field in the Building Browser will indicate that the current solution is Up-
to-Date. 

Double-clicking in any result cell of the Desktop that contains a graph, will open a 
separate window in which you can change the view settings and orientation of the 
graph as well as print the contents of the window.  See Editing Desktop Graphics 
below. 

Solutions 
Solutions are represented as columns in the Desktop.  The first column contains 
parameter names corresponding to the values in the Solution columns.   

Display solutions 
Any existing solutions will be displayed automatically in the Decision Desktop.  

Move solutions 
At this time, solutions cannot be moved in the Desktop.  Solutions are displayed in 
the order they are created. 

Update solutions 
When any change is made to a particular solution in the SGE, or to its objects or 
parameters in the Building Browser, the relevant solution name on the Decision 
Desktop column header will turn red, to indicate that the displayed results are not 
valid, that is they do not correspond to the current description of the solution. The 
Status field in the Building Browser indicates whether the current solution is Stale 
or Up-to-Date. To recalculate the values of displayed parameters, follow the 
procedure described above under Calculate Selected Parameters. 
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Editing Desktop graphs 
The appearance of the graphs displayed in the Decision Desktop may be customized.  
You may change the graph type, view, angle, text, etc.  You may also save graphs as 
graphics files in bitmap, metafile or enhanced metafile formats,  or send them to a 
printer.  

To customize a graph: 

Double-click on the graph you wish to customize.  Depending on the type of graph, a 
2-dimensional (2D), 3-dimenstional (3D), or Schedule graph display box will open.   

The File menu on the graph display window can be used to save the contents of the 
graph display window to a file or to send it to a printer.  The Edit menu is used to 
copy the contents of the graphical display window to the clipboard in three different 
formats: bitmap, metafile, or enhanced metafile. The Settings button opens a 
Settings dialog which can be used to change the graph appearance. 

Edit 2D graphs 
If you double-click on a 2D graph on the Desktop, a 2D graph display box will open.  
The changes you may make to the graph include changing the graph type (Bar Chart, 
Stacked Bar, or Pie Chart), show/hide the title and legend, and edit the chart title. 

 
2D Graph Display dialog box 

To modify the graph: 

1. Click on the Settings button to open the 2D Graph Settings dialog 
box. 
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2D Graph Settings dialog box 

2. You can change the graph type (Bar Chart, Stacked Bar, or Pie Chart) 
by selecting a radio button under Graph Type; show or hide the title 
and legend by selecting the corresponding checkbox; and edit the chart 
title by typing in the Chart Title entry field. 

3. When you are satisfied with the changes, click OK to return to the 2D 
Graph Display window. 

4. Select the Apply Changes to Cell or the Apply Change to entire row 
check box. 

5. Click Apply. 

Edit 3D graphs 
If you double-click on a 3D graph on the Desktop, a 3D graph display will open.  In 
this type of display, you may rotate the image with the mouse while holding down 
both mouse buttons.  The changes you may make to the graph include changing the 
graph type (Surface Mesh or 3D Bar), show/hide the legend and title, contour 
projection, and editing the title text and maximum value (z-value).  When computing 
the values for a new solution, the y and z values of the plots are automatically set to 
the maximum value for easy comparison of multiple solutions. 
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3D Graph Display dialog box 

To modify the graph: 

1. Click on the Settings button.  The 3D Settings dialog box will open. 

 
3D Graph Settings dialog box 

2. You can change the graph type (Surface Mesh or 3D Bar) by selecting 
a radio button under Graph Type; select or deselect the Show Title, 
Show Legend, and Project contours above graph checkboxes; change 
the maximum value of the parameter value axis (z-axis); and edit the 
chart title by typing in the Chart Title entry field.   

3. When you are satisfied with the changes, click OK to return to the 3D 
Graph Display window. 

4. Select the Apply Changes to Cell or the Apply Change to entire row 
check box. 

5. Click Apply. 
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Edit schedule graphs 
If you double-click on a schedule graph on the Desktop, a graph display for 
schedules will open.  Graphical displays for schedules are very similar to 2D graphs, 
with the exception that you may modify the values of the data displayed in a 
Schedule graph. 

To modify values in a Schedule graph display, click and hold the mouse button 
above the top of a bar representing the value to be changed.  The cursor will change 
to a double-headed arrow.  While still holding the mouse button down, change the 
height of the bar by moving the mouse.  

To modify a graphical display for a schedule: 

1. Click on the Settings button to open the Schedule Graph Settings 
dialog box. 

 
Graph Display dialog box for schedules 

2. You can change the graph type (Bar Chart, Stacked Bar, or Pie Chart) 
by selecting a radio button under Graph Type; show or hide the title 
and legend by selecting the corresponding checkbox; and edit the chart 
title by typing in the Chart Title entry field. 

3. When you are satisfied with the changes, click OK to return to the 
Schedule Graph Display window. 

4. Select the Apply Changes to Cell or the Apply Change to entire row 
check box. 

5. Click Apply. 

Printing and exporting graphs 
Graphs may be sent directly to a printer, saved to a file in one of three formats 
(bitmap, metafile, and enhanced metafile), or copied and pasted in one of the same 
three formats.  If you are unsure of which format to use, try bitmap first. 
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Print graphs 
To print a graph: 

1. Double-click on the graph in the Decision Desktop.  The graph will 
open in a separate window. 

2. From the File menu on the graph window, select Print.  A standard 
Print dialog box will open. 

Export graphs 
Graphs may be saved in external files in bitmap, metafile, or enhanced metafile 
format.  To export a graph: 

1. Double click on the graph in the Decision Desktop.  The graph will 
open in a separate window. 

2. From the File menu on the graph window, select Save.  A standard 
Save As dialog box will open.  Make sure to select the appropriate file 
format and choose the location where the file will be saved. 

Copy graphs 
If you wish to copy a graph to paste into another application, use one of the three 
copy functions available.   

To copy a graph: 

1. From the Edit menu on the graph window, select Copy as Bitmap, 
Copy as Metafile, or Copy as Enhanced Metafile, depending on 
the file format you wish to use.   

2. Open the file or application where the graph will be pasted, such as a 
word-processing document. 

3. Paste the graph using the paste function of that application. 

Customizing the Desktop 
At this time, customizing the appearance of the Desktop is limited to resizing its 
rows and columns. 

Resize rows and columns 
To resize a row, place the cursor over the line below the row.  When the cursor 
changes from a cross to a line between two arrows, hold the left mouse button down 
and drag the line up or down to change the height of the row. 

To resize a column, place the cursor over the line to the right of the column up in 
the column-heading row.  When the cursor changes from a cross to a line between 
two arrows, hold the left mouse button down and drag the line to the left or right to 
change the width of the row. 



 

User's Guide to  Building Design Advisor Tutorial  ••••  49 

Tutorial 

Launch the BDA Application 
Select Building Design Advisor from the Programs section of the Start Menu 
on your Desktop. The main BDA window will open. 

 
Main BDA tool bar 

Create a new project 
To create a BDA Project, select New… from the Project Menu. The Creating a 
New Project dialog box will open. Enter "MyOffice" as the Name of the Project. 
Select "Office" as the Building Type from the pull-down list. Select "USA" as the 
Country. Select "CA" (California) and "SAN_DIEGO" as the State and City, 
respectively. Click on OK after you have made the selections.  
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New Project Dialog Box 

Create a New Design Solution in SGE 
BDA will create the new Project file and launch the Schematic Graphic Editor 
(SGE). SGE pops up as a window just below the main BDA tool bar.  

 
The Schematic Graphic Editor 

 

 
New Solution Button 

Select New Solution from the File menu in SGE or click on the New Solution 
button. The New Solution Dialog box will open. Specify "North Windows" as the 
solution name and click OK. The New Story Dialog box will open. 

 
New Solution Dialog Box 

Create a New Story in SGE 
Specify "Floor 1" as the new Story Name. The Story has the Height of 10 ft. and 
has no Plenum by default. Accept the defaults and click OK. 
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New Story Dialog Box 

Note: By default, roofs are created with each story.  

Create Two New Spaces in SGE 

 
Grid Settings Button 

Once you have created a Story, the drawing screen becomes visible. Before you 
begin drawing spaces check the Grid Settings by clicking on the Grid button. By 
default, the drawing canvas is 200 ft. wide and 100 ft. high. The grid interval is 4 ft. 
Accept the default values and click OK.  

 

 
The drawing screen for the SGE 
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New Space Button 

In the next few steps, we are going to create two spaces, an office and a conference 
room. After the completion of these steps the spaces should look like the spaces 
drawn in the figure below.  

Click on the Space button on the SGE tool bar, or select the menu item Object → 
Create → Space.  Select "Office (general)" as the Space Type from the drop-
down list of available space types. The cursor will change to the drawing mode 
cross-wire shape. You need to draw a space that is 24 ft. in length (6 grid intervals in 
the X-direction) and 16 ft. in width (4 grid intervals in the Y-direction). To draw, 
click and release the left mouse button to specify each corner of the room. Double 
click to close the resulting polygon  (double click at the end point of the third wall, 
to make a rectangle in this case). The Space Name Dialog box will open. Type 
"Office" as the name of the space and click OK. The name of the space appears on 
the screen as a text object. Position it over the newly created space and click to 
anchor the name in the desired position. 

Similarly, create another room of Type "Conference", 16 ft. X 16 ft., next to 
"Office" as shown in the figure below. Name the space "Conference". 

 
Create two new spaces in SGE  

 

Add Windows to the Spaces 

 
The Window Tool Button 

Select the space "Office" to add a Window to one of its walls. You can select the 
space by clicking on one of its walls or its name. This will activate the Window tool 
button. Click on the button and draw a window in the north wall of the space named 
"Office" by clicking and releasing the left mouse button to specify each of the two 
end points of the window. The window should be 8 ft. wide and centered on the wall 
as shown below. 
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Adding windows to the spaces 

Similarly, add another window to the space named "Conference". The window 
should be 8 ft. wide and centered on the north wall of the conference space. 

 

Add Luminaires to a Space 

 
The Luminaire Tool Button 

Select the space "Office" to add luminaires. You can select the space by clicking on 
one of its walls or its name. This will activate the Luminaire tool button. Click on 
the button and click once on the grid point in the upper-left corner of the space to 
add a luminaire at this point. Select the toolbar button again and click within the 
space to add each additional luminaire. Add a total of six luminaires as shown in the 
drawing below. 

 
Adding luminaires to a space 

 

Navigate the Building Model in the Building Browser 

 
The Building Browser Button 

From the BDA main menu select the Building Browser button. The Building 
Browser will open. The Building Browser (BB) organizes all the building objects 
in a hierarchical manner and gives the user a simple and familiar means of 
navigating through the BDA building model and editing the values of objects and 
parameters. The Building Browser has two main panes. The left pane displays the 
Object instances and their Relationships. The right pane displays related Object 
instances and the Parameters associated with the Object selected in the left pane. 
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The Building Browser 

Click on the plus (+) sign next to the City Name (SAN_DIEGO, in this case) to 
open the object tree. Continue expanding the tree until you reach the Space level. 
Click on the icon next to "Office". The right pane of the BB now displays the objects 
and parameters associated with "Office". Scroll down to the bottom where the 
parameters of Type "Performance" are listed. These do not have values associated 
with them yet because their values are computed when we run simulations. Select 
"temporal_daylight_illuminance" by clicking on the Checkbox next to it. Also 
select "spatial_electric_light_iluminance". 

Let’s select one more "performance" parameter at the Building level. Click on the 
icon next to the Building "MyOffice" in the left pane. In the right pane, select the 
parameter "doe2_monthly_energy_by_end_use" by clicking on the Checkbox next 
to it. Push the Update Desktop button in the top, right hand corner of the 
Building Browser. The Decision Desktop opens. 
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Compute and View Results on the Decision Desktop 

 
The Calculation Button 

The Parameters selected from the Building Browser appear in the Decision 
Desktop, each in a new row. The name of the Parameter is displayed in the first 
column, and its Value for each solution is displayed in the corresponding Solution 
column. To calculate the values of the performance parameters displayed in the 
Desktop for the current Solution, select Calculate Results from the SimTools 
menu on the main BDA toolbar, or click the Calculation button on the main BDA 
toolbar. You can also click on any solution name on the top of the Desktop columns 
to calculate its results. 

BDA will take a few seconds to run DOE-2, ECM and DElight to compute the 
results. The results will appear in the relevant cells of the Decision Desktop.  

 
The Decision Desktop 

Double-Click on the graph for "temporal_workplane_illuminance". The graph will 
open in a separate window. Maximize this window. Drag while holding down both 
mouse buttons to see the graph from different angles. Close the window when you 
are done. 
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Graph for Temporal Illuminance 

Add a Second Design Solution 
Make the SGE the active window. You need to create a new design solution that is 
similar to the first solution but has south facing windows. 

 
New Solution Button 

Select New Solution from the File menu in SGE or click on the New Solution 
button. The New Solution Dialog box will open. Specify "South Windows" as the 
solution name and click OK. A new solution is created as a duplicate of the first 
solution. 

 

Change the Window Location 

 
The Window Tool Button 

Delete the existing windows by selecting them one at a time and pushing the Delete 
key. Select the space "Office" to add a Window to its south wall. Click on the 
Window button and draw a window in the south wall of "Office" by clicking and 
releasing the left mouse button to specify each of the two end points of the window. 
The window should be 8 ft. wide and centered on the wall. 

Similarly, add another window to the space named "Conference". The window 
should be 8 ft. wide and centered on the south wall of the conference space as shown 
below. 
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Adding windows on the south walls 

Navigate the Second Solution in the Building Browser 
BDA automatically sets the new solution as the current solution in the Building 
Browser. Confirm that the new  solution ("South Windows") is selected in the 
drop-down list on the top left hand corner of the Building Browser. The Building 
Browser displays the Building Model for the selected solution. Expand the 
Building tree until you reach the Space level. Click on the icon next to "Office". 
The right pane of the BB now displays the objects and parameters associated with 
"Office". Scroll down to the bottom where the parameters of Type "Performance" are 
listed. BDA has automatically set the parameters for computation in the new 
solution. Confirm that the parameters "temporal_workplane_illuminance" and 
"spatial_electric_light_illuminance" are selected by seeing if the Checkboxes next to 
them have a red cross. 

Similarly, confirm that the parameter "doe2_monthly_energy_by_end_use" at the 
Building level is selected. 

 
The Building Browser 

Compute Results for the Second Solution 
When you create a new Solution in SGE, BDA makes a copy of the Source 
Solution and another column is created in the Desktop.  Whatever parameters 
were on the Desktop in the source solution, their exact copy will also be on the 
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Desktop in the new Solution. These results are not valid for the New Solution 
since you have changed the window location.  

 
The Calculation Button 

To re-calculate the results select Calculate Results from the SimTools menu on 
the main BDA toolbar, or click the Calculation button on the main BDA toolbar. 
You can also click on the new solution name on the Desktop to calculate its results. 
The new calculated values will appear in the cells of the new Solution column 
replacing the copies of the values from the source Solution. 

 
The results for the new solution 

Add a Third Design Solution 
Make the SGE the active window and the second solution the active solution. You 
need to create a new design solution that is similar to the second solution but the 
luminaires have a direct/indirect lighting distribution. 

 
New Solution Button 

Select New Solution from the File menu in SGE or click on the New Solution 
button. The New Solution Dialog box will open. Specify "Indirect lighting" as the 
solution name and click OK. A new solution is created as a duplicate of the second 
solution. 
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Change the Luminaire Type 
In the SGE, right mouse click on the space called "Office". From the pop-up menu 
select Highlight Object in Building Browser. The Space object is highlighted 
in the Building Browser as shown below.  

 
The space is highlighted in the Building Browser 

Select any one of the luminaire objects in the right pane of the Building Browser. 
Double click on the luminaire object. The Object Information dialog box opens. 
The current luminaire type is "RLS Small 3". Scroll down in the list of Available 
Prototypes and select "RLS Small 4" for the new luminaire type. Note that the 
prototype description specifies a partly indirect lighting distribution. Select the radio 
button for "Change all objects with the same value" and click OK. This will modify 
all luminaires of "RLS Small 3" type to "RLS Small 4" type. Confirm this in the 
Building Browser. 
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Object Information for luminaire 

Compute Results for the Third Solution 

 
The Calculation Button 

To re-calculate the results select Calculate Results from the SimTools menu on 
the main BDA toolbar, or click the Calculation button on the main BDA toolbar. 
You can also click on the new solution name ("Indirect lighting") on the Desktop to 
calculate its results. The new calculated values will appear in the cells of the new 
Solution column replacing the copies of the values from the source Solution. You 
can resize the Decision Desktop if you want to see the results of all three 
solutions together. 

Save the Project 
To save your work without closing, select Save from the Project menu.  Then 
select Exit from the Project menu to exit BDA. The project is saved in the Projects 
Database. 
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BDA Building Model 

The BDA Building Model represents the semantic network of all design object types 
and all possible relationships between them.  The first section of this chapter defines 
all of the object types and lists their associated parameters.  The second section 
defines the parameters. 

Objects 
Aperture 
An opening in a boundary_segment which may contain a window, skylight, door or trapdoor.  Only windows are 
supported in the current version of BDA. 

parameters: 
        effective_thermal_conductance 
        effective_thermal_resistance 
        height 
        percentage_glazing_area 
        reference_point_co-ordinates 
        surface_area 
        width 

relationships: 
        composed_of Overhang 
        composed_of Fins 
        has Ground_Surface 
        part_of Boundary_Segment 
        composed_of Glazing 
        composed_of Frame 

Boundary 
A physical building plane separating two spaces. 

parameters: none 

relationships: 
        contains Boundary_Segment 
        part_of  Space 

Boundary_Segment 
Portion of a boundary (Wall, Ceiling, or Floor) is adjacent to two spaces, or one space and the exterior. 

parameters: 



62  ••••  BDA Building Model User's Guide to  Building Design Advisor 

        surface_area 

relationships: 
        has Construction 
        contained_in Boundary 
        composed_of Aperture 
        composed_of Finish 

Building 
Set of grouped spaces defined by a common exterior envelope. 

parameters: 
        azimuth 
        building_type 
        daylight_run_hour 
        daylight_run_month 
        default_floor_to_floor_height 
        doe2_monthly_energy_by_end_use 
        doe2_monthly_energy_by_fuel_type 
        doe2_total_energy_by_end_use 
        doe2_total_energy_by_fuel_type 
        doe2_total_energy_use 
        gross_area 
        reference_point_co-ordinates 

relationships: 
        composed_of Building_Shade 
        composed_of Heating_Plant 
        composed_of Cooling_Plant 
        composed_of Distribution_System 
        has Hourly_Schedule 
        composed_of HVAC_Zone 
        composed_of Story 

Building_Location 
The building location choices determine the Terrain and Height Modifications for Wind_Speed.   

parameters: 
        shielding_coefficient 
        terrain_parameter1 
        terrain_parameter2 

relationships: 
        had_by Site 

Building_Shade 
A rectangle adjacent to the building that casts a shade on the building that rotates with the building.   

parameters: 
        visible_reflectance 
        visible_transmittance 

relationships: 
        has Monthly_Schedule 
        faced_by Ground_Surface 
        part_of Building 
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Construction 
Assembly of layers composed of different materials which define a boundary_segment. 

parameters: 
        boundary_type 
        effective_thermal_conductance 
        effective_thermal_resistance 
        inside_film_resistance 

relationships: 
        composed_of Material 
        had_by Boundary_Segment 

Cooling_Plant 
The primary equipment that uses energy to provide cooling to a building. 

parameters: 
        autosizing_safety_factor 
        coefficient_of_performance 
        cooling_tower_electricity_consumption 
        fuel_type 
        generation_capacity 
        monthly_cooling_loads 
        monthly_electric_input_to_cooling 
        monthly_electrical_energy 
        number_of_units 
        operation_type 
        rated_pump_power 
        unit_configuration 

relationships: 
        uses Distribution_System 
        has Monthly_Schedule 
        part_of Building 

Distribution_System 
Set of equipment connecting the cooling and heating plants with the HVAC_zone. 

parameters: 
        cool_coil_discharge_temperature 
        economizer_enthalpy_control 
        economizer_limit_temperature 
        fan_control_type 
        heat_coil_discharge_temperature 
        minimum_design_ventilation 
        minimum_outside_air_fraction 
        minimum_relative_humidity 
        monthly_cooling_energy 
        monthly_electrical_energy 
        monthly_fan_electrical_energy 
        monthly_heating_energy 
        rated_fan_capacity 
        rated_fan_power 

relationships: 
        used_by Heating_Plant 
        used_by Cooling_Plant 
        part_of Building 
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        used_by HVAC_Zone 
        has Temperature_Reset_Control 

External_Obstruction 
See Building_Shade. 

Finish 
Coating or treatment used as the innermost or outermost construction layer (e.g., paint). 

parameters: 
        boundary_type 
        outside_emissivity 
        roughness 
        solar_absorptance 
        visible_reflectance 

relationships: 
        part_of Boundary_Segment 
        facing Space 

Fins 
Attached shades used in shading calculations for a wall and its apertures. The Left and Right fins are determined as seen 
from the outside of the aperture.  They are vertically attached to the wall where the aperture is located.  

parameters: 
        left_fin_distance_from_aperture_frame 
        left_fin_top_edge_below_aperture_frame 
            _top_edge 
        left_fin_total_depth 
        left_fin_total_height 
        right_fin_distance_from_aperture_frame 
        right_fin_top_edge_below_aperture_frame 
             _top_edge 
        right_fin_total_depth 
        right_fin_total_height 

relationships: 
        part_of Aperture 

Fixed_Shade 
This could be a constructed element or a natural element, like a tree, that shades the exterior of the building. A fixed 
shade stays static when a building rotates.  This version of BDA does not support fixed shades, only building shades, 
which rotate with the building. 

parameters: 
        azimuth 
        height 
        reference_point_co-ordinates 
        tilt 
        visible_reflectance 
        visible_transmittance 
        width 

relationships: 
        faced_by Ground_Surface 
        has Hourly_Schedule 
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Frame 
Enclosing, perimeter structure for an aperture element. 

parameters: 
        thermal_absorptance 
        thermal_conductance 
        thermal_resistance 
        width 

relationships: 
        part_of Aperture 

Glazing 
Aperture element which is composed of glass. 

parameters: 
        angular_dependence_coeff_of_trans1 
        angular_dependence_coeff_of_trans2 
        angular_dependence_coeff_of_trans3 
        angular_dependence_coeff_of_trans4 
        angular_dependence_coeff_of_trans9 
        glass_type_code 
        inside_visible_reflectance 
        number_of_panes 
        outside_emissivity 
        shading_coefficient 
        thermal_conductance 
        thermal_resistance 
        type_of_glass 
        visible_transmittance 

relationships: 
        has Glazing_Spacer_Type 
        part_of Aperture 

Glazing_Spacer_Type 
Type of spacers between the panes of the glazing. 

parameters: 
        spacer_type 

relationships: 
        had_by Glazing 

Ground_Surface 
Ground surface on the site directly outside of an aperture or building_shade. 

parameters: 
        visible_reflectance 

relationships: 
        facing Fixed_Shade 
        facing Building_Shade 
        had_by Aperture 

HVAC_Zone 
An agglomeration of one or more spaces with similar comfort conditioning requirements operated by the same HVAC 
control (e.g., thermostat). 
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parameters: 
        monthly_baseboard_energy 
        monthly_heat_addition_load 
        monthly_heat_extraction_load 
        monthly_hours_undercooled 
        monthly_hours_underheated 
        monthly_maximum_zone_temperature 
        monthly_minimum_zone_temperature 

relationships: 
        part_of Building 
        uses Distribution_System 
        contains Space 

Heating_Plant 
Primary equipment that uses energy to provide heating to a building. 

parameters: 
        autosizing_safety_factor 
        fuel_type 
        full_load_efficiency 
        generation_capacity 
        monthly_electric_input_to_heating 
        monthly_electrical_energy 
        monthly_fuel_input_to_heating 
        monthly_heating_loads 
        number_of_units 
        operation_type 
        pilot_energy_consumption 
        rated_pump_power 
        unit_configuration 

relationships: 
        uses Distribution_System 
        has Monthly_Schedule 
        part_of Building 

Hourly_Schedule 
Defines hourly values for occupancy or equipment status for weekdays, Saturdays and Sundays. 

parameters: 
        saturday_values 
        schedule_type 
        sunday_values 
        weekday_values 

relationships: 
        had_by Fixed_Shade 
        had_by Building_Shade 
        had_by Space 
        had_by Building 

Infiltration_Method 
Method used to calculate infiltration for the zone.  

parameters: none 

relationships: 
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        has Hourly_Schedule 

Lighting_Control 
System controlling the electrical lighting fixtures within a space. 

parameters: 
        light_output_fraction_at_min_power 
        lighting_control_probability 
        minimum_input_power_fraction 
        number_of_steps_in_stepped_system 

relationships: 
        uses Reference_Point 
        had_by Space 

Lighting_Type 
Used to specify the type of overhead lighting used in the space. e.g. supended fluorescent, or recessed fluorescent- 
vented or not vented, or incandescent. For mixed types og lighting within the same space, the recommended procedure is 
to select the dominant type and adjust the percentage of heat produced by the lighting in 'Light to Space'. 

parameters: none 

relationships: 
        had_by Space 

Luminaire 
The electrical lighting fixture within a space. 

parameters: 
        ies_type 
        input_watts 
        light_source 
        luminaire_manufacturer 
        rotation 

relationships: 
        part_of Space 
        used_by Reference_Point 

Material 
Substance that can be used as a layer in a construction. 

parameters: 
        conductivity 
        density 
        materials_library_code 
        specific_heat 
        thermal_conductance 
        thermal_resistance 
        thickness 

relationships: 
        part_of Construction 

Monthly_Schedule 
Defines monthly values for plant or distribution_system availability for an entire year. 

parameters: 
        monthly_values 
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        schedule_type 

relationships: 
        had_by Cooling_Plant 
        had_by Heating_Plant 
        had_by Space 

Overhang 
Attached shade used in shading calculations for a wall and its apertures.  It is horizontally attached to the wall where the 
aperture is located.  

parameters: 
        overhang_angle 
        overhang_height_above_the_aperture_frame 
        overhang_total_depth 
        overhang_total_width 
        overhang_width_beyond_the_aperture_frame 

relationships: 
        part_of Aperture 

Plenum 
Air space between the ceiling of a space and the floor of the space above it. 

parameters: 
        air_volume_ratio 
        gross_area 
        volume 

relationships: 
        part_of Story 

Reference_Point 
Defines the position of an observer or of a control point within a space. 

parameters: 
        electric_light_illuminance 
        x_value 
        y_value 

relationships: 
        used_by Lighting_Control 
        uses Luminaire 
        part_of Space 
 

Site 
Geographic location of a project typically defined by the name of the closest city. 

parameters: 
        altitude 
        atmospheric_moisture 
        atmospheric_turbidity 
        cec_climatic_zone 
        cooling_degree_days(65) 
        cooling_degree_hours(80) 
        heating_degree_days(65) 
        latitude 
        longitude 
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        mean_coinc_summer_wetbulb_temp 
        mean_daily_temperature_range 
        mean_summer_coincident_humidity 
        summer_maximum_drybulb_temp 
        summer_maximum_wetbulb_temp 
        time_zone 
        unit_system 
        wind_speed 
        winter_minimum_drybulb_temp 

relationships: 
        has Building_Location 
        has Weather_Station_Location 

Space 
Architectural volume enclosed on all sides by construction boundaries. 

parameters: 
        air_changes_per_hour 
        air_volume_ratio 
        annual_electric_lighting_savings 
        area_per_person 
        cooling_setback_temperature 
        cooling_setpoint_temperature 
        doe2_annual_electric_lighting_savings 
        doe2_monthly_electric_lighting_savings 
        doe2_ecm_annual_electric_lighting_savings 
        doe2_ecm_monthly_electric_lighting_savings 
        equipment_heat_gain_latent_fraction 
        equipment_heat_gain_sensible_fraction 
        equipment_heat_to_hood_ratio 
        equipment_power_density 
        floor_to_ceiling_height 
        fraction_of_space_covered_by_furniture 
        grid_step 
        gross_area 
        heating_setback_temperature 
        heating_setpoint_temperature 
        hot_water_use_per_person 
        light_heat_to_space_ratio 
        lighting_control_type 
        lighting_power_density 
        luminaire_suspension_length 
        min_outside_air_per_person 
        miscellaneous_heat_to_hood_ratio 
        miscellaneous_power_density 
        monthly_electric_lighting_savings 
        occupant_orientation 
        rectangular 
        spatial_glare_index 
        spatial_daylight_illuminance 
        spatial_electric_light_illuminance 
        temporal_glare_index 
        temporal_daylight_illuminance 
        thermal_activity_type 
        ventilation_rate_per_person 
        visual_activity_type 
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        volume 
        workplane_height 

relationships: 
        has Lighting_Type 
        has Visual_Activity 
        has Thermal_Activity 
        has Lighting_Control 
        has Monthly_Schedule 
        has Hourly_Schedule 
        part_of Story 
        composed_of Luminaire 
        composed_of Reference_Point 
        faced_by Finish 
        composed_of Boundary 
        contained_in HVAC_Zone 

Story 
Set of architectural spaces sharing the same level of a building.  Multi-story spaces belong to their bottom story. 

parameters: 
        floor_to_floor_height 
        level 

relationships: 
        composed_of Plenum 
        composed_of Space 
        part_of Building 

Temperature_Reset_Control 
Mechanism which controls the temperature reset of the HVAC distribution_system. 

parameters: 
        cool_coil_max_discharge_temperature 
        outside_high_limit_temperature 
        outside_low_limit_temperature 

relationships: 
        had_by Distribution_System 

Thermal_Activity 
Activity that alters the heat gain of a space. 

parameters: 
        people_latent_heat_gain 
        people_sensible_heat_gain 

relationships: 
        had_by Space 

Visual_Activity 
Activity that requires a certain minimum illuminance or lighting_setpoint. 

parameters: 
        lighting_setpoint 

relationships: 
        had_by Space 
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Weather_Station_Location 
Determines the Terrain and Height Modifications for Wind_Speed. . 

parameters: 
        wind_speed_measurement_height 
        wind_speed_terrain_parameter1 
        wind_speed_terrain_parameter 

relationships: 
        had_by Site 

Parameters 
Air_changes_per_hour 
The number of infiltration-caused air changes per hour at a wind speed of 10 mph for a space.  Dimension: none 

Air_volume_ratio 
The ratio of space air volume to space geometric volume.  Dimension: percentage 

Altitude 
Height above sea level.  Dimension: length 

Angular_dependence_coeff_of_trans (1-9) 
Coefficients in the angular dependence equation for solar transmittance in glazing.  Dimension: none 

 

Annual_electric_lighting_savings 
Percentage of electric lighting savings  that daylighting contributes for each month of a year.  Savings are calculated by 
DELight based on the average daylight illuminance over the whole space.  Dimension: percentage 

Area_per_person 
Average floor area per person in a space at maximum (100%) occupancy.  Dimension: area 

Atmospheric_moisture 
Amount of precipitable moisture in the atmosphere at a particular site at a particular time.  Dimension: moisture 

Atmospheric_turbidity 
Amount of aerosols (i.e. particulate pollutants) in the atmosphere.  Dimension: none 

Autosizing_safety_factor 
Plant equipment sizing safety factor used by the Autosizing simulation tool to calculate design day loads.  Dimension: 
percentage 

Azimuth 
Angular distance from a reference location (usually 0 degrees).  Dimension: plane_angle 

Boundary_type 
Type of boundary (exterior wall, interior wall, ceiling, floor, roof).  Dimension: none 

Building_shade_transmittance 
The percentage of solar energy transmitted through the material of the building_shade.  Dimension: percentage 
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Building_type 
Type of building (residential, non-residential, etc.).  Dimension: none 

CEC_climatic_zone 
One of 16 geographic areas in California for which the California Energy Commission (CEC) has established 
prescriptive energy efficiency requirements.  Dimension: none 

Coefficient_of_performance 
Ratio of the rate of heat removed or delivered to the rate of energy input for a complete plant unit or system. Represents 
efficiency of the plant or system.  Dimension: none 

Conductivity 
The quantity of heat that will flow through one square foot of homogeneous material, one inch thick, in one hour, when 
there is a temperature difference of one degree Fahrenheit between its surfaces. In DOE2.1E, the entry for this is 
expressed per foot of thickness, not per inch. Hence, values given per inch must be divided by 12 to obtain the correct 
entry.  Dimension: thermal_conductivity 

Cool_coil_discharge_temperature 
Designed exit air temperature of the system cooling coil.  Dimension: temperature 

Cool_coil_max_discharge_temperature 
Maximum coil exit air temperature achievable by reset or discriminator.  Dimension: temperature 

Cooling_degree_days(50) 
Annual cummulative difference between a site's mean daily temperature and 50°F.The difference is counted only if the 
mean daily temperature is above 50°F.  Dimension: degree_day 

Cooling_degree_days(65) 
Annual cummulative difference between a site's mean daily temperature and 65°F. The difference is counted only if the 
mean daily temperature is above 65°F.  Dimension: degree_day 

Cooling_degree_hours(80) 
Annual cummulative difference between a site's mean hourly temperature and 80°F.  The difference is counted only if 
the mean hourly temperature is above 80°F.  Dimension: degree_hour 

Cooling_setback_temperature 
Cooling thermostat setting during unoccupied periods.  Dimension: temperature 

Cooling_setpoint_temperature 
Cooling thermostat setting during occupied periods.  Dimension: temperature 

Cooling_tower_electricity_consumption 
Total electricity consumption of the cooling tower during normal operation.  Dimension: power 

Daylight_run_hour 
Hour of the day for which the DELight simulation runs the spatial calculation (acceptable values are 0 - 23). The day is 
assumed to be the 21st of the month.  Dimension: none 

Daylight_run_month 
Month of the year for which the DELight simulation runs the spatial calculation (acceptable values are 1 - 12). The day is 
assumed to be the 21st of the month.  Dimension: none 
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Default_floor_to_floor_height 
Default vertical distance between the floor of one story and the floor of the story above it.  Dimension: length 

Density 
Specifies the material density i.e. the mass of a substance per unit volume.  Dimension: density 

DOE2_annual_electric_lighting_savings 
Percentage of electric lighting savings  that daylighting contributes for each month of a year.  Savings are calculated by 
DOE2.1E based on daylight illuminance at the center of the space.  Dimension: percentage 

DOE2_ECM_annual_electric_lighting_savings 
Percentage of electric lighting savings  that daylighting contributes for each month of a year.  Savings are calculated by 
DOE2.1E based on daylight illuminance and the electric lighting illuminance at a user-specified reference point.  
Dimension: percentage 

DOE2_ECM_monthly_electric_lighting_savings 
Percentage of electric lighting savings  that  daylighting contributes for each hour of an average day in each month of a 
year.  Savings are calculated by DOE2.1E based on daylight illuminance and the electric lighting illuminance at a user-
specified reference point.  Dimension: percentage 

DOE2_monthly_electric_lighting_savings 
Percentage of electric lighting savings  that  daylighting contributes for each hour of an average day in each month of a 
year.  Savings are calculated by DOE2.1E based on daylight illuminance at the center of the space.  Dimension: 
percentage 

DOE2_monthly_energy_by_end_use 
Energy use of the building for each month, as calculated by DOE2.1E, broken down by end use such as space heating 
and cooling, fans, lighting, equipment, hot water, miscellaneous and heat reject.  Dimension: energy 

DOE2_monthly_energy_by_fuel_type 
Energy use of the building for each month, as calculated by DOE2.1E,  broken down by fuel type such as electricity, gas, 
coal, #2 oil, #6 oil, district heating, district cooling, miscellaneous, and heat reject.   Dimension: energy 

DOE2_total_energy_by_end_use 
Total energy use of the building, as calculated by DOE2.1E, broken down by the end uses such as space cooling and 
heating , fans, lighting, equipment, hot water, miscellaneous and plant standby. Also HVAC aux, aux solar, cooling 
towers, pumps etc.  Dimension: energy 

DOE2_total_energy_by_fuel_type 
Total energy use of the building, as calculated by DOE2.1E,  broken down by fuel type such as electricity, gas, coal, #2 
oil, #6 oil, district heating, district cooling, other, and heating plant. Also, chilled water, steam, LPG, methanol and 
biomass.  Dimension: energy 

DOE2_total_energy_use 
All the energy used by a building during the year including all fuel types and all end uses, as calculated by DOE2.1E.  
Dimension: energy 

Economizer_enthalpy_control 
Indicates whether or not the economizer enthalpy control is in effect (acceptable values are " yes"  or  "no").  
Dimension:none 
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Economizer_limit_temperature 
Outside air temperature above which the economizer returns to minimum outside air operation.  Dimension: temperature 

Effective_thermal_conductance 
Thermal conductance of a construction assembly including all framing, edge and interstitial effects but excluding air film 
on both sides.  Dimension: thermal_conductance 

Effective_thermal_resistance 
Net thermal resistance of a construction assembly including all framing, edge and interstitial effects but excluding air 
film on both sides.  Dimension: thermal_resistance 

Electric_light_illuminance 
The illuminance level at a reference point due to electric lighting.  Dimension: illuminance 

Electricity_and_fuel_usage_meter_by_meter 
A performance parameter that shows calculated and projected electricity and fuel usage for each meter of the building.  
Dimension:energy 

Equipment_heat_gain_latent_fraction 
The fraction of the maximum equipment energy that is added to the space energy balance in the form of latent heat. The 
sum of equipment_heat_gain_latent_fraction and  equipment_heat_gain_sensible_fraction must not exceed 1.00. If 
neither sensible or latent gain is specified, all heat from equipment will be considered sensible in DOE2.1E.  Dimension: 
percentage 

Equipment_heat_gain_sensible_fraction 
This is the fraction of the maximum equipment energy, if any, that is added to the space energy balance in the form of 
sensible heat. The sum of equipment_heat 
_gain_latent_fraction and equipment_heat_gain 
_sensible_fraction must not exceed 1.00. If neither sensible or latent gain is specified, all heat from equipment will be 
considered sensible in DOE2.1E.  Dimension: percentage 

Equipment_heat_to_hood_ratio 
Fraction of heat from electrical equipment that is exhausted through a hood.  Dimension:percentage 

Equipment_power_density 
Maximum installed equipment plug load power density in a space.  Dimension:power_density 

Fan_control_type 
Refers to the method by which the HVAC distribution_system fans are controlled.  Dimension:none 

Floor_to_ceiling_height 
Vertical distance between a floor boundary and a ceiling boundary. Dimension: length 

Floor_to_floor_height 
Vertical distance between two floor boundaries (includes the plenum if one exists).  Dimension: length 

Fraction_of_space_covered_by_furniture 
The fraction of floor area covered by furniture. This parameter effects the interior mass of the building.  Dimension: 
percentage 
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Fuel_type 
Primary type of fuel used by plant equipment.  Dimension: none 

Full_load_efficiency 
Operating efficiency of plant generation equipment at full load (100% operation).  Dimension: percentage 

Generation_capacity 
Maximum equipment sustained power output.  Dimension: power 

Glass_type_code 
A code number from the more than 200 possible choices in the DOE 2.1E Windows library. DOE-2.1E incorporates 
about 200 glass types from the Window 4.0 program based on single-, double-, triple-glazing, different tints, coatings, 
gas-fills, glass-thickness, gap widths.  Dimension: none 

Grid_step 
Distance between the calculated reference_points.  X and Y values in a lighting grid are assumed to be equal.  
Dimension: length 

Gross_area 
Area included within surrounding exterior walls exclusive of interior courtyards.  Dimension: area 

Heat_coil_discharge_temperature 
Designed exit temperature of the system heating coil. Dimension: temperature 

Heating_degree_days(65) 
Annual cummulative difference between a site's mean daily temperature and 65°F. The difference is counted only if the 
mean daily temperature is below 65°F.  Dimension: degree_day 

Heating_setback_temperature 
Heating thermostat setting during unoccupied periods.  Dimension: temperature 

Heating_setpoint_temperature 
Heating thermostat setting during occupied periods.  Dimension: temperature 

Hot_water_use_per_person 
Maximum total domestic hot water usage per person exclusive of space heating or equipment process usage.  Dimension: 
volumetric_flow 

Hourly_extraction_rate 
The value the extraction rate (cooling) would be at the design conditions. This is not the value used in the simulation; 
that value is recalculated hourly and depends upon the loads, the conditions, the thermostat type, and the thermostatic 
throttling range. Dimension: energy (kBtu/hr) 

Ies_type 
The name of the IES formatted file that contains the luminaire specifications.  Dimension: none 

Infiltration_method_type 
This parameter represents the infiltration_method, namely, none, air-change, crack, or residential.  Dimension: none 

Input_watts 
The rated power input for a luminaire.  Dimension: power 
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Inside_film_resistance 
Specifies the combined convective and radiative air film resistance for the Inside wall, ceiling or floor surface. 
Dimension: none 

Inside_visible_reflectance 
Total inside (i.e. within a space) visible reflectance of a glazing assembly.  Dimension: percentage 

Latitude 
Angular distance from the plane of the Earth's equator to the site.  Dimension: plane_angle 

Layer_1, layer_2, …, layer_9 
Layers in a Construction Material Sandwich. Dimension:none 

Left_fin_distance_from_aperture 
Horizontal distance between the fin and the  closest vertical edge of the aperture.  Dimension: length 

Left_fin_distance_from_aperture_frame 
Horizontal distance between the fin and the closest vertical edge of the aperture frame.  Dimension: length 

Left_fin_top_edge_below_aperture_frame_top_edge 
The height between the top edge of the aperture and the top edge of the fin. If this height is a positive number,  the top of 
the  fin starts below the top of the aperture by a distance equal to that number. If this height is a negative number,  the top 
of the fin starts above the top of the aperture by a distance equal to that number. Dimension: length 

Left_fin_top_edge_below_aperture_top_edge 
The height between the top edge of the aperture and the top edge of the fin. If this height is a positive number,  the top of 
the  fin starts below the top of the aperture by a distance equal to that number. If this height is a negative number,  the top 
of the  fin starts above the top of the aperture by a distance equal to that number. Dimension: length 

Left_fin_total_depth 
Total depth of the fin perpendicular to the aperture.   Dimension: length 

Left_fin_total_height 
Total height of the fin along the aperture.   Dimension: length 

Level 
The actual position of a story within the building, starting with 1 for the ground floor. Dimension: none 

Light_heat_to_space_ratio 
Fraction of lighting energy added to the space energy balance as a sensible heat gain.  Dimension: percentage 

Light_output_fraction_at_min_power 
Fraction of light produced by an electric lighting system when the lighting_control is set at minimum power. Dimension: 
percentage 

Light_source 
The lamp type used by a luminaire, e.g., fluorescent, incandescent, metal halide, halogen, etc.  Dimension: none 

Lighting_control_probability 
Probability that the lighting_control will dynamically respond in meeting lighting setpoint conditions. Dimension: 
percentage 
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Lighting_control_type 
Type of lighting control device used. Dimension: none 

Lighting_power_density 
Installed lighting power density within a space. Dimension: power_density 

Lighting_setpoint 
Desired lighting level for the type of visual_activity occuring in a space or zone.  Dimension: illuminance 

Longitude 
Angular distance from the plane of Earth's prime (Greenwich) meridian to the site.  Dimension: plane_angle 

Luminaire_manufacturer 
The manufacturer or distributor of a particular luminaire type.  Dimension: none 

Luminaire_suspension_length 
The vertical distance between the luminaire center and the ceiling.  Dimension: length 

Mean_coinc_summer_wetbulb_temp 
Mean wetbulb temperature coincident with the summer design day maximum drybulb temperature. Dimension: 
temperature 

Mean_daily_temperature_range 
Mean daily temperature range during design day conditions.  Dimension: temperature 

Mean_summer_coincident_humidity 
Mean humidity ratio coincident with the summer design day maximum drybulb temperature.  Dimension: percentage 

Min_outside_air_per_person 
Minimum outside air volumetric flow per person required in a space.  Dimension: volumetric_flow 

Minimum_design_ventilation 
Minimum design ventilation provided to an HVAC_zone by a distribution_system during occupied conditions.  
Dimension: percentage 

Minimum_drybulb_temperature 
Minimum drybulb temperature experienced by a site under design day conditions.  Dimension: temperature 

Minimum_input_power_fraction 
Minimum power fraction when the lighting_system is operating at minimum power.  Dimension: percentage 

Minimum_outside_air_fraction 
Minimum acceptable constant flow rate of fresh air expressed as a fraction of the total air supply.  Dimension: 
percentage 

Minimum_relative_humidity 
Minimum allowable relative humidity in an HVAC_zone.  Dimension: percentage 

Miscellaneous_heat_to_hood_ratio 
Fraction of heat from space miscellaneous equipment (e.g, a steam table),  that is exhausted through a hood.  Dimension: 
percentage 
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Miscellaneous_power_density 
Maximum miscellaneous equipment (e.g., steam table) power density installed within a space.  Dimension: 
power_density 

Monthly_baseboard_energy 
Baseboard energy consumed monthly.  Dimension: energy 

Monthly_cooling_energy 
Energy consumed for cooling on a monthly basis.  Dimension: energy 

Monthly_cooling_loads 
Loads on the cooling_plant on a monthly basis.  Dimension: energy 

Monthly_electric_input_to_cooling 
Electric energy consumed by the plant for cooling on a monthly basis.  Dimension: energy 

Monthly_electric_input_to_heating 
Electric energy consumed by the plant for heating on a monthly basis.  Dimension: energy 

Monthly_electric_lighting_savings 
Percentage of electric lighting savings  that  daylighting contributes for each hour of an average day in each month of a 
year.  Savings are calculated by DELight based on average daylight illuminance over the whole space.  Dimension: 
percentage 

Monthly_electrical_energy 
Electric energy consumed on a monthly basis.  Dimension: energy 

Monthly_energy_by_end_use 
Energy use of the building for each month broken down by end use such as  space heating and cooling, fans, lighting, 
equipment, hot water, pumps, miscellaneous, and heat reject.  Dimension: energy 

Monthly_energy_by_fuel_type 
Energy use of the building for each month broken down by fuel type such as electricity, gas, coal, #2 oil, #6 oil, district 
heating, district cooling, other and heating plant.  Dimension: energy 

Monthly_fan_electrical_energy  
Electrical energy consumed by the fan on a monthly basis.  Dimension: energy 

Monthly_fuel_input_to_heating 
Fuel consumed by the plant for heating on a monthly basis.  Dimension: energy 

Monthly_heat_addition_load 
This monthly total is the sensible heating requirement of this zone during the HVAC system operation hours. The loads 
are both sensible and latent. For a plenum, this values is for heat addition induced by the return air flow. For 
unconditioned zones, this values should be zero.  Dimension: energy (millions Btu) 

Monthly_heat_extraction_load 
This monthly total is the sensible cooling requirement of this zone during the HVAC system operation hours. The loads 
are both sensible and latent. For RESYS systems, the heat extraction may include natural ventilation. For a plenum, this 
value is for heat extraction and addition induced by the return air flow. For unconditioned zones, these values should be 
zero.  Dimension: energy  (millions Btu) 
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Monthly_heating_energy 
Energy consumed for heating on a monthly basis.   Dimension: energy 

Monthly_heating_loads 
Loads on the heating_plant on a monthly basis.  Dimension: energy 

Monthly_hours_undercooled 
The number of hours each month that the zone temperature was above the comfort range.  Dimension: time 

Monthly_hours_underheated 
The number of hours each month that the zone temperature was below the comfort range.  Dimension: time 

Monthly_maximum_zone_temperature 
The maximum zone temperature month by month.  Dimension: temperature 

Monthly_minimum_zone_temperature 
The minimum zone temperature month by month.  Dimension: temperature 

Monthly_values 
Twelve values, one for each month of the year.  Dimension: percentage 

Number_of_fins 
Number of fins (i.e. vertical exterior shading projections) associated with the aperture.  Dimension: none 

Number_of_overhangs 
Number of overhangs (i.e. horizontal exterior shading projections) associated with the aperture.  Dimension: none 

Number_of_panes 
Specifies whether glazing is single, double or triple.  Dimension: none 

Number_of_steps_in_stepped_system 
Number of steps (i.e. lighting level settings) in a stepped lighting system.  Dimension: none 

Number_of_units 
Total number of heating or cooling generation units in a plant.  Dimension: none 

Occupant_orientation 
Direction toward which the occupant of a space is facing.  Dimension: plane_angle 

Occupied_infiltration_rate 
Infiltration rate during "occupied conditions".   This infiltration_rate generally refers to the rate when the HVAC system 
is "on".  Dimension: volumetric_flow 

Operation_type 
Value denotes how the plant operates (acceptable values are "continuous" or "as needed").  Dimension: none 

Outside_emissivity 
The infrared emissivity of the outside surface. It makes a difference in the loads calculations.  Dimension: percentage 

Outside_high_limit_temperature 
High limit outside temperature at which coil reset begins.  Dimension: temperature 
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Outside_low_limit_temperature 
Low limit outside temperature at which coil reset stops.  Dimension: temperature 

Overhang_angle 
The angle between the overhang and the aperture (window). When set at 90 degrees, the overhang is perpendicular to the 
window. If less than 90 degrees, it is tilted down. If more than 90 degrees, it is tilted up. The range is 0 to 180 degrees.  
Dimension: plane_angle 

Overhang_height_above_the_aperture_frame 
The vertical distance of the overhang from the top horizontal edge of the aperture frame.  Dimension: length 

Overhang_height_above_the_lintel 
The vertical distance of the overhang from the top horizontal edge of the aperture.  Dimension: length 

Overhang_total_depth 
The total depth of the overhang perpendicular to the window surface.  Dimension: length 

Overhang_total_width 
The total width of the overhang along the aperture.  Dimension: length 

Overhang_width_beyond_the_aperture_frame 
The extended width of the overhang beyond the vertical edge of the aperture frame.  Dimension: length 

Overhang_width_beyond_the_lintel 
The extended width of the overhang beyond the vertical edge of the aperture.  Dimension: length 

People_latent_heat_gain 
Total people latent heat gain given off to a space.  Dimension: people_heat_gain 

People_sensible_heat_gain 
Total people sensible heat gain given off to a space.  Dimension: people_heat_gain 

Percentage_glazing_area 
Percentage of the aperture surface area which is composed of glazing. The remaining percentage is assumed to be 
composed of the framing.  Dimension: percentage 

Pilot_energy_consumption 
Total energy consumption of the plant gas pilots (if any).  Dimension: power 

Rated_fan_capacity 
Total  rated fan capacity, measured in terms of volumetric flow, produced by a HVAC distribution_system's fans.  
Dimension: volumetric_flow 

Rated_fan_power 
Total fan power necessary to operate the HVAC distribution system fans at full capacity. Dimension: power_efficiency 

Rated_pump_power 
Total maximum pump power available from the plant.  Dimension: power 

Rectangular 
Whether a space is rectangular in shape or not; valid values are "yes" or "no".  Dimension: none 
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Reference_point_co-ordinates 
Reference_point_co-ordinates are to be used with Fixed_Shades, i.e. shades that do not rotate with the building.   
Dimension: length 

Right_fin_distance_from_aperture 
Horizontal distance between the fin and the closest vertical edge of the aperture.  Dimension: length 

Right_fin_distance_from_aperture_frame 
Horizontal distance between the fin and the closest vertical edge of the aperture frame.  Dimension: length 

Right_fin_top_edge_below_aperture_frame_top_edge 
The height between the top edge of the aperture frame and the top edge of the fin. If this height is a positive number,  the 
top of the fin starts below the top of the aperture by a distance equal to that number. If this height is a negative number,  
the top of the  fin starts above the top of the aperture by a distance equal to that number.  Dimension: length 

Right_fin_top_edge_below_aperture_top_edge 
The height between the top edge of the aperture and the top edge of the fin. If this height is a positive number,  the top of 
the  fin starts below the top of the aperture by a distance equal to that number. If this height is a negative number,  the top 
of the  fin starts above the top of the aperture by a distance equal to that number.  Dimension: length 

Right_fin_total_depth 
Total depth of the fin perpendicular to the aperture.    Dimension: length 

Right_fin_total_height 
Total height of the fin along the aperture.    Dimension: length 

Rotation 
The rotation of an object, measured counter-clockwise from the X-axis.    Dimension: plane_angle 

Roughness 
It is specified as a code-number that indicates the relative roughness of the exterior surface finish of an Exterior Wall or 
Roof.  Dimension: none 

Saturday_values 
Hourly values for a typical Saturday.  Dimension: percentage 

Schedule_type 
Type of schedule (e.g., occupancy, lighting, availability, etc.).  Dimension: none 

Shading_coefficient 
Ratio of solar heat gain through a fenestration product  to solar gain through an unshaded 1/8" thick clear double strength 
glass under the same set of conditions without the effect of frames, mullions or sashes etc.  Dimension: percentage 

Shielding_coefficient 
Takes into account the shading from the surrounding trees and buildings.  This is used in calculations for the Sherman 
Grimsrud infiltration method.  This coefficient modifies the wind speed term in the model to account for changes in the 
wind pressure caused by local obstructions.  Dimension: none 

Solar_absorptance 
Portion of the radiant solar energy striking the surface that is absorbed by the substance.  Dimension: percentage 
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Spacer_type 
The thermal values for a 2.5" external strip around the edge of the glass depend on U-value in the center of the glass and 
the Type of Spacer.  Spacers in the glazing can be specified as aluminum, steel etc. or they are taken directly from the 
Window Library in DOE-2.1E.  Dimension: none 

Spatial_glare_index 
Glare index measured at a single time over a  grid of reference points.  Dimension:none 

Spatial_daylight_illuminance 
Daylight illuminance measured at a single time over a grid of reference points.  Dimension: illuminance 

Spatial_electric_light_illuminance 
Electric lighting illuminance measured at a single time over a grid of reference points.  Dimension: illuminance 

Specific_heat 
The heat in calories required to raise the temperature of one gram of a substance one degree Celsius  Dimension: 
specific_heat 

Summer_maximum_drybulb_temp 
Maximum drybulb temperature experienced by a site under summer design day conditions.  Dimension: temperature 

Summer_maximum_wetbulb_temp 
Maximum wetbulb temperature experienced by a site under summer design day conditions.  Dimension: temperature 

Sunday_values 
Hourly values for a typical Sunday.  Dimension: percentage 

Surface_area 
Area of a surface plane.  Dimension: area 

Temporal_glare_index 
Glare index measured over time at a single reference point.  Dimension: none 

Temporal_daylight_illuminance 
Daylight illuminance measured over time at a single reference point.  Dimension: illuminance 

Terrain_parameter1 
A constant used to modify the free stream wind speed to account for ground roughness and height above ground at the 
building site. Values range from 0.47 for the centre of a big city to 1.30 for the ocean.  Dimension: none 

Terrain_parameter2 
A constant used to modify the free stream wind speed to account for ground roughness and height above ground at the 
building site. Values range from 0.35 for the centre of a big city to 0.10 for the ocean.  Dimension: none 

Thermal_absorptance 
Portion of the radiant solar energy striking the surface that is absorbed by the substance.  Dimension: percentage 

Thermal_activity_type 
Thermal_Activity prototype most likely for a given Space  prototype.  Dimension: none 
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Thermal_conductance 
Rate of heat flow though a unit area of a body induced by a unit temperature difference between the surfaces.  
Dimension: thermal_conductance 

Thermal_resistance 
Mean temperature difference between two defined surfaces of a material or construction that induces unit heat flow 
through a unit area under steady conditions.  Dimension: thermal_resistance 

Thickness 
Smallest of the three linear measurements.  Dimension: length 

Tilt 
Angular distance from a vertical plane perpendicular to the window for fins and from a horizontal plane perpendicular to 
the window for overhangs.  Dimension: plane_angle 

Time_zone 
Time zone of the project site location. Dimension: none 

Total_energy_by_end_use 
Total energy use of the building broken down by the end uses such as space cooling and heating , fans, lighting, 
equipment, hot water, miscellaneous and plant standby. Also HVAC aux, aux solar, cooling towers, pumps etc.  
Dimension: energy 

Total_energy_by_fuel_type 
Total energy use of the building broken down by fuel type such as electricity, gas, coal, #2 oil, #6 oil, district heating, 
district cooling, other, and heating plant. Also, chilled water, steam, LPG, methanol and biomass.  Dimension: energy 

Total_energy_use 
All the energy used by a building during the year including all fuel types and all end uses.  Dimension: energy 

Transmittance 
The percentage of thermal gain or light transmitted through the material.  Dimension: percentage 

Type_of_glass 
Type of glass used in a glazing assembly (i.e. transparent or translucent).  Dimension: none 

Unit_configuration 
Configuration of plant unit operation (acceptable values are "parallel"  or "staged").  Dimension: none 

Unit_system 
The system of units to be used for the numeric parameter values. The choice is between English and Metric units.  
Dimension: none 

Unoccupied_infiltration_rate 
Infiltration_rate during "unoccupied" conditions.  This infiltration rate generally refers to the rate when the HVAC 
system is "off".  Dimension: volumetric_flow 

Ventilation_rate_per_person 
Average ventilation volumetric flow per occupant.  Dimension: volumetric_flow 
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Visible_reflectance 
Ratio of visible light reflected by a surface to the light incident upon it.  Dimension: percentage 

Visible_transmittance 
Visual property which rates the relative translucence of a material.  Dimension: percentage 

Visual_activity_type 
Visual_Activity prototype most likely for a given Space prototype.  Dimension: none 

Volume 
Length multiplied by width multiplied by height of a space expressed as cubic units.  Dimension: volume 

Weekday_values 
Hourly values for a typical weekday.  Dimension: percentage 

Width 
The horizontal length of an element, e.g. a window or a shading device.  Dimension: length 

Wind_speed 
The local wind speed of the building site.  Dimension: velocity 

Wind_speed_measurement_height 
Height (in feet) above ground level at which the wind_speed measurement was made.  For most weather stations, this 
information can be obtained from Local Climatological Data- Annual Summaries for 1981, published by: The National 
Climatic Data Center, Federal Building, Ashville, NC 28801.  Dimension: length 

Wind_speed_terrain_parameter1 
A constant used to modify the free stream wind_speed to account for ground roughness and height above ground at the 
location of the weather station. Values range from 0.47 for the centre of a big city to 1.30 for the ocean.  Dimension: 
none 

Wind_speed_terrain_parameter2 
A constant used to modify the free stream wind speed to account for ground roughness and height above ground at the 
location of the weather station. Values range from 0.35 for the centre of a big city to 0.10 for the ocean.  Dimension: 
none 

Winter_minimum_drybulb_temp 
Minimum drybulb temperature experienced by a site under winter design day conditions.  Dimension: temperature 

Workplane_height 
Height from the floor at which the DELight simulation calculates the spatial illuminance.  Dimension: length 

X_value 
The X-coordinate for a reference point in terms of the global coordinate system.  Dimension: none 

Y_value 
The Y-coordinate for a reference point in terms of the global coordinate system.  Dimension: none 


